
Setting up
for the Internet
Setting up your Series 5

for Email & Web

Version 2.00
May 1999
English



Setting up for the Internet 2

© Copyright Psion Computers Plc 1997-1999
Reproduction in whole or in part, including utilisation in machines capable of reproduction or retrieval, without the express written permission of the
copyright holders is prohibited. Reverse engineering is also prohibited.
The information in this document is subject to change without notice.
Some names referred to are registered trademarks.

© Copyright Symbian Ltd. 1997-1999
Part of the IMAP4 software addition is © Copyright ANT Ltd. 1998. All rights reserved.
Incorporates MPPC compression from Hi/fnTM.
Stac , LZS , ©1996, Stac, Inc., ©1994-1996 Microsoft Corporation. Includes one or more U.S. Patents: No. 4701745, 5016009, 5126739,
5146221, and 5414425. Other patents pending.
Incorporates LZS compression from Hi/fnTM.
Hi/fn , LZS , ©1988-98, Hi/fn. Includes one or more U.S. Patents: No. 4701745, 5016009, 5126739, 5146221, and 5414425. Other patents
pending.



Setting up for the Internet 3

Contents
Introduction to setting up .................................................................................................. 5
Memory requirements ........................................................................................................................................................ 5
Before setting up.................................................................................................................................................................. 6

Overview of setting up ....................................................................................................... 7
Connecting your Series 5 and modem ............................................................................................................................... 7

Quick set up for advanced users ...................................................................................... 7

Quick set up for Infrared Mobile phones .......................................................................... 8

Setting up the Control panel sections and Email ............................................................ 9
Specifying the type of modem you use............................................................................................................................... 9
Setting the location you dial from...................................................................................................................................... 9
Specifying your Internet Service Provider...................................................................................................................... 10
Entering your email and fax settings in Email................................................................................................................ 11
Setting up to send SMS messages..................................................................................................................................... 12

Testing your setup............................................................................................................ 12
Testing your connection in Web ...................................................................................................................................... 12
Testing your connection in Email .................................................................................................................................... 12
Sending a test SMS message............................................................................................................................................. 13

How do I…?....................................................................................................................... 14
…add a new modem?........................................................................................................................................................ 14
…add a new mobile phone modem? ................................................................................................................................ 14
…remove a modem from the list? .................................................................................................................................... 14
…control the modem loudspeaker? ................................................................................................................................. 14
…change the modem speed?............................................................................................................................................. 14
…use an infrared modem? ............................................................................................................................................... 15
…just dial the number I type? ......................................................................................................................................... 15
…use a call back service? ................................................................................................................................................. 15
…add a new location?....................................................................................................................................................... 15
…tell my Series 5 to disable Call Waiting? ..................................................................................................................... 15
…change the dial out code?.............................................................................................................................................. 16
…use pulse dialling? ......................................................................................................................................................... 16
…use a chargecard?.......................................................................................................................................................... 16
…disable a chargecard? ................................................................................................................................................... 16
…tell the modem not to wait for a dial tone?.................................................................................................................. 16
…change the length of time I stay connected for?.......................................................................................................... 17
…set alternative access numbers? ................................................................................................................................... 17
…disable my alternative access numbers? ...................................................................................................................... 17
…add a new Internet service?.......................................................................................................................................... 17
…add a new Internet service based on a template? ....................................................................................................... 17
…remove a Internet service from the list?...................................................................................................................... 18
…set up a direct-line connection?.................................................................................................................................... 18
…specify my IP address?.................................................................................................................................................. 18
…specify the DNS addresses? .......................................................................................................................................... 18
…enable PPP extensions?................................................................................................................................................. 18
…disable plain text authentication? ................................................................................................................................ 18
...change where messages are stored................................................................................................................................ 18



Setting up for the Internet 4

Appendix: The scripting language .................................................................................. 19
Overview of creating connection scripts ......................................................................................................................... 19
When to use scripts ........................................................................................................................................................... 19
How to use scripts ............................................................................................................................................................. 19
Creating a script for your Internet Service Provider..................................................................................................... 20
Scripting language commands.......................................................................................................................................... 26

Index .................................................................................................................................. 28



Setting up for the Internet 5

Introduction to setting up
This manual contains information about setting up your Series 5 so that you can connect to the Internet, and set up Email
to send and receive fax, email and SMS messages. This section starts with a list of the information that you need to collect
about your modem, phone line and Internet connection. It then leads you through the process of setting up.
• Read the ‘Setting up the Control panel sections and Email’ section for full details on setting up your Series 5.
• If you are an experienced Series 5 user and are familiar with setting up computers to connect to the Internet, read the

‘Quick setup for advanced users’ section.
• Read the ‘Quick setup for Infrared mobile phones’ section for information on how to set up your Series 5 to work

with an infrared mobile phone.
• If the setup instructions don’t cover all the things you need, see the ‘How do I...?’ section for more details.

Memory requirements
Please note the approximate memory requirements for running the software:
• To run Email and send and receive messages, you should have at least 1000K free.
• To install and run Web and open an average-sized Web page with graphics, you should have at least 2500K free.

These figures are guidelines only. The actual memory requirements of either Email or Web at any particular time will
depend largely on the nature of the information you are sending or receiving from your Internet service.
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Before setting up...
Before you start setting up your Series 5, ensure you have all the information in the table below.

Information you need: Where to find it: Write the
information in
here for reference:

The make and model of your modem. On the modem itself, or in the modem’s
documentation.

The speed you should use your modem
at.

In the documentation that came with your
modem. If your modem is in the list of pre—
defined modems, you shouldn’t need to adjust
this. To view the list of pre-defined modems,
open the Modems section of the Control
panel, and tap in the Current modem line.

If the phone line you are using has a
Call Waiting facility - the code you
need to dial to disable Call Waiting.

From your telephone network operator.

If you want to use a chargecard - the
account number and PIN of the card.

In the documentation that accompanied your
chargecard.

If you want to use a chargecard - the
order in which information such as
your account number and PIN should
be sent.

In the documentation that accompanied your
chargecard.

The phone number to connect to your
service provider. (This is often called a
Point Of Presence or POP.)

From your Internet Service Provider, or in the
information you received when you opened
your account.

The username and password for your
Internet account.

From your Internet Service Provider, or in the
information you received when you opened
your account.

Whether or not you need to specify
your IP address when you connect.
Only a small number of service
providers require this.

From your Internet Service Provider. If you
are in doubt, leave the setting which tells the
Series 5 to get the IP address on connection.

Whether or not you need to specify
your service provider’s DNS addresses
when you connect. Only a small
number of service providers require
this.

From your Internet Service Provider. If you
are in doubt, leave the standard setting which
tells the Series 5 to get the DNS addresses on
connection.

Whether or not your service provider
requires you to perform a text-based -
or script-based - login. Only a small
number of service providers require
this.

From your Internet Service Provider.

Your email address. From the administrator for your email account.
This will often be your Internet Service
Provider.

The username and password you
should use to log in to your mailbox.

From the administrator for your email account.
This will often be your Internet Service
Provider.

The name of the email server for
incoming messages (e.g. the POP3
server or IMAP4 server).

From the administrator for your email account.
This will often be your Internet Service
Provider.

The name of the email server for
outgoing messages (e.g. the SMTP
server).

From the administrator for your email account.
This will often be your Internet Service
Provider.
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Overview of setting up
Before connecting your Series 5 to the Internet, you need to set up your machineusing the information you
gathered in the previous section. This consists of five stages:
1. Connecting the Series 5 to a modem and phone line.
2. Choosing the type of modem you use.
3. Setting the location you are dialling from.
4. Choosing the Internet Service Provider you use to connect to the Internet.
5. Entering email-specific settings in Email (if you wish to use email).
The following sections describe each of these stages in turn.

The dialogs you use when setting up the new sections of the Control panel on your Series 5 have Help buttons. Tap
Help to find out more information on how to complete a dialog.

Connecting your Series 5 and modem
The first stage of connecting to the Internet is to connect your Series 5 to a modem and phone line and set them up for
communication.
To do this:
1. Connect your modem to a phone line and, if necessary, to a power supply. Make sure the modem is switched on.
2. Connect the modem to the serial port of your Series 5 using the appropriate cable.

Quick set up for advanced users
If you are familiar with configuring Internet software, you may want to set up your Series 5 quickly using the table below.
It tells you what information you need to put in each Control panel section in the System screen, and what you need to set
up in the Email program.

Setting: What to set up there:
Modems section of Control
panel

• Set up your modem. Use the New button if the list does not include your
type of modem, then enter the settings you use.

• Use the Edit button to change any of the modem settings. To change the
modem speed, use the Modem page. To change the loudspeaker volume,
use the Options page.

Dialling section of Control
panel

• Set up the location you dial from. On the Location page, tap Edit to alter
any of the settings or New to enter new dialling details.

• On the Location page, select your current country and enter your area
code.

• Use the Dial out page to enter any prefixes you need to add to get an
outside line.

• If you want to use a chargecard from the location you are setting up, tick
the box on the Chargecard page and tap the Options button. Select Edit,
or New if the list of pre-defined chargecards does not contain your type of
card. Enter your account details on the Details page and the order
information should be sent on the Rules page.

• Use the Dial settings page to indicate whether you use tone or pulse
dialling, and whether you need to wait for dial or proceed tones while
dialling out.

The Tone dialling page in the Dialling section of the Control panel is the same
as the one covered by your Series 5 User Guide, and applies to normal DTMF
dialling, not dialling via a modem.



Setting up for the Internet 8

Internet section of Control
panel

• Set up your Internet service provider.
• Tap New and select whether you want to base the service you are setting

up on standard settings or settings from a ‘template’ file on your Series 5.
• Enter the your access number (dial-up number) on the Service page,

including the country and area codes.
• Tick the Use smart dialling box if you just want the software to dial the

number as entered in the Standard dial-up number line.
• Use the Login page to change between 7 bit and 8 bit data.
• If your service provider requires you to perform a text-based login, you

will need to use a script. If you are adding a new service, you may need to
tick the Use login script box on the Login page and edit the example
script.

Email account settings Select Add new account|Email on the Tools menu in Email.
On the Account page:
• Enter the Account details including Your name and Email address that

you want to appear on outgoing messages.
• If the option is available, select your Mailbox type, and tick the Set as

default account box to make this the default account.
On the Outgoing page:
• Enter the address of  the Email (SMTP) server.
• If the option is available, tick the Auto send on opening box to send

messages as soon as you connect to the mailbox.
On the Incoming page:
• Enter the address of the server you receive email from in the mailbox type

server line.
• Enter your Mailbox login username and enter and confirm the password

for your mailbox.
For fax settings:
• Select Account settings|Fax on the Tools menu. Enter the number where

you can receive faxes in the Fax number line.

Quick set up for Infrared Mobile phones
If your mobile phone has a built-in infrared port and modem, and is supported by your EPOC communications software,
connecting to the Internet with your Series 5 while you're on the move is quick and easy.
To do this:
1. Open the Dialling section of the Control panel in the System screen and select Mobile in the Current location line.

Tap OK.
2. Open the Modems section of the Control panel and select Infrared mobile phone as your Current modem. Tap OK.
3. Open the Internet section of the Control panel. Tap New and enter the details of your account with an Internet

service provider. Tap Done, then OK.
4. In Email, make sure you have entered your email account settings using Add new account on the Tools  menu.
You are now set up to use Email and Web with your mobile phone. When you want to connect, make sure:
• The infrared port on your phone is enabled. You should do this just a short time before attempting to connect. Your

phone's documentation will tell you how to do this.
• The infrared ports on your phone and Series 5 are facing each other.
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Setting up the Control panel sections and Email
This section provides detailed information about how to enter the setup information in the Control panel sections and in
Email.

Specifying the type of modem you use
Once you’ve connected your Series 5 and modem, the next stage is to specify your type of modem. Your Series 5 has a
number of pre-defined modem settings to make this easier.
To do this:

1. Open the Control panel in the System screen and open the Modems  section.
2. Tap in the Current modem box or press Tab to see the list of pre-defined modems.
3. Select the modem you use, or a modem from the list which you know is compatible with your own. Tap OK.

If the modem you use doesn’t appear in the list, select ‘Generic modem settings’. If the generic settings don’t work
for your modem, you can add settings for a new one. See “…add a new modem” in the ‘How do I…?’ section later
on.

Setting the location you dial from
When you connect to the Internet, your Series 5 instructs the modem to dial out. You need to specify the location you’re
dialling from, so that your Series 5 can automatically adjust the number, e.g. by adding a 9 to get an outside line from an
office telephone system. This automatic adjustment is known as smart dialling.
To set the location you dial from:

1. Open the Dialling  section of the Control panel in the System screen.

2. In the Current location line, select your location. The pre-defined locations have the following settings:

Pre-defined
location

Connection
type

Dial out prefix Disables Call Waiting Uses
chargecard

Office Fixed line Yes: “9,” for both local
and long distance numbers

No No

Mobile Mobile No No No
Home Fixed line No No No
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If your location doesn’t correspond to any of the pre-defined locations, you can create a new one using the New
button.

3. Select Edit to change any of the settings for the Current location. Make sure that:
• In the Country line of the Location page, you select your current country.
• In the Area code line, you enter your current area code.
For more information on each of the settings, tap the Help button on the appropriate page of the dialog.

Specifying your Internet Service Provider
Once you have set up your modem and location, you need to enter details about the Internet service that you use to
connect to the Internet.
To do this:

1. Open the Internet section  of the Control panel in the System screen.
2. Tap the New button and:
• On the Service page, enter the your access number in the Standard dial-up number line. Include the country and

area codes. (You may need to omit the first 0 from the area code.)

• On the Account page, remove the tick from the Manual login box and enter the username and password for your
Internet account. Tap Done, then OK.

If your Internet Service Provider requires you to specify your IP address or the DNS addresses, or requires you to log
on using a 7 bit setting for data transfer, change these settings on the Addresses and Login pages. For more details,
use the Help button on the dialog pages, and see the ‘How do I…?’ section in this guide.

If your service provider requires you to perform a text-based or script-based login, you will need to enter a script on
the Login page. If you are creating a new Internet service and need to create a new script, see the appendix on
scripting at the end of this guide.



Setting up for the Internet 11

Entering your email and fax settings in Email
The final stage of the setting up process is entering your email and fax details in Email.
To start Email:
• Tap on the Email icon.

Entering email settings
To enter the email settings:
1. Select the Add new account|Email command from the Tools menu.
2. Enter the following on the Account page of the dialog:
• Account name: Enter a name for the account (this can be anything you want).
• Your name: This will appear on emails you send.
• Email address: This is the email address that will appear on emails you send, and should be the address you want

others to send replies to.
• Mailbox type: If the Mailbox type line is present, select the type of email account you use. Most email accounts are

POP3 or IMAP4.
• Set as default account: Tick this box if you plan to use multiple mail accounts, but want most of your new messages

to be created and sent using the details from this account. (You can change the account used for sending individual
messages by opening the message and using the command on the Tools menu.)

3. Enter the following on the Outgoing page:
• Email (SMTP) server: This is the server through which outgoing email will be sent.
•• Auto send on opening: If this box is available, remove the tick if you don’t want email in your outbox to be

automatically sent when you connect to this mail account.
4. Enter the following on the Incoming page:
• Server: This is the server used to receive email messages (e.g. POP3 or IMAP4).
• Mailbox login: This is the mailbox login name provided by your Internet Service Provider.
• Mailbox password: This is the password you need to use to access your Remote mailbox.
• Confirm password: Enter your password again for confirmation.

Advanced email settings
Tap the Advanced button when you are editing the Email account settings if you need to:
• Specify your SMTP or POP3/IMAP4 port number.
• Turn off MIME encoding of messages.
• Specify that your Series 5 should use "Secure password authentication".

Entering fax settings
To enter the fax settings:
1. Select the Account settings|Fax command from the Tools menu.
2. On the Details page enter the:
• Fax number: This is normally the phone number where you can receive faxes, i.e. your private fax machine, one you

have access to (e.g. the fax machine in your office), or the number of the phone line your Series 5 is connected to.
This number will be printed on the top of faxes you send.

You can only enter ‘+’, space, and digits ‘0’-’9’ in the Fax Number line.
• Your name: Enter the name you want to be printed at the top of the faxes you send.
• Preferred resolution: This is normally set to fine. This is the resolution you will send faxes in and would prefer to

receive faxes in. Change this to normal if you want to reduce the size of the fax, or if the fax machine you are sending
to can only receive normal faxes.

• Show connection dialog: Remove the tick from this box if you don’t want to display the Connection dialog each
time you send a fax.

3. On the Modem page enter the:
• Max. fax speed: If you have problems sending or receiving faxes because of a poor quality phone connection, you

can lower this value.
• Faxback delay: Enter the number of seconds that you want the modem to wait after dialling a faxback number before

it expects the fax to be sent.

The standard settings on the Modem page are designed to work with most setups, so you may want to leave them as
they are.
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Setting up to send SMS messages
If you have an account with a phone network which supports SMS, you can use Email to send SMS messages.
Email will attempt to retrieve the correct SMS settings from your phone.
To set up to send an SMS:
1. Ensure Infrared is active on your phone (your phone manual will tell you how to do this) and that the Infrared ports

of your phone and your Series 5 are aligned.
2. Open Email, and select Account settings|SMS on the Tools menu.
3. Select the type of phone you are using to send messages in the Mobile phone line.
4. Tap on the Advanced page. Ensure your phone and Series 5 are ready to communicate and tap the Edit service

centre address button.

Testing your setup

Testing your connection in Web
Once you’ve followed the above steps to configure the Control panel, you can test your connection to your Internet
Service Provider using Web. You can install the Web program from the PsiWin CD ROM.
To do this:
1. Open Web.
2. Tap in the location line, or select Open web page on the File menu, and enter the address of any World Wide Web

page, e.g. “www.psion.com”. Tap OK.
3. A connection dialog will appear showing the settings you entered earlier:
4. If all the details are correct, tap OK to connect. Web will then connect to the Internet and retrieve the page you want.

If you experience any difficulties connecting using Web, select Help on Web on the Tools menu to display a list of
help topics. You can view a list of topics that deal with problems by typing ‘troubleshooting’ as a search clue with
the Quick find button on the Toolbar pressed.

This test confirms that you can connect to your service provider correctly, and retrieve information from the World Wide
Web.

To disconnect from the World Wide Web when using Web, select Disconnect from Internet on the File menu.

Testing your connection in Email
A good way of testing that Email is set up correctly is to send yourself an email message, then retrieve it from your
Remote mailbox.
To send the email message:
1. Tap on the Email icon.
2. Tap the New button on the Toolbar and select Email.
3. Enter your own email address in the To: line, then enter some text in the Subject: line and the message area.
4. Tap the Save to outbox button on the Toolbar.
5. Tap on the Outbox icon in the left-hand Folder list, then tap Send on the Toolbar and select Email. If you are not

already connected to the Internet, the connection dialog appears. If the details are correct, tap OK to start the
connection. If any of the settings are incorrect, you’ll need to change them in the Control panel in the System screen.

Email will automatically disconnect from the Internet once it has sent the email message. To change this, open the
Internet section of the Control panel and enter the time you want the connection to remain open in the On exit, stay
online for box. If you are connected to the Internet elsewhere (i.e. through Web or an open mailbox), this option will
not come into effect until you go to close the last connection.

To get the message from your mailbox:
1. Wait for a few minutes to give the message time to arrive. Then tap the Open mailbox button on the Toolbar and

select your mailbox.
2. When the connection appears, tap OK.
3. A list of the messages you’ve received will appear in the Remote mailbox. Select the test message and tap the Copy

(inbox) button on the Toolbar, or use the Move to inbox command on the Transfer menu.

Copying emails from your mailbox to your inbox leaves a copy on the server. Moving an email deletes the message
from the server when it has successfully been moved to your Series 5.

If you experience any difficulties connecting using Email, select Help on Email on the Tools menu to display a list
of help topics. You can view a list of topics that deal with problems by typing ‘troubleshooting’ as a search clue
with the Quick find button on the Toolbar pressed.

This test confirms that you can connect to your service provider correctly, and send and receive email.
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Sending a test SMS message
To do this:
1. Open Email, tap New on the Toolbar and select SMS.
2. Enter the number of the phone you want to send the message to, followed by your message, then use Save to outbox

on the Toolbar.
3. Make sure your phone and Series 5 are ready to communicate, then use Send on the Toolbar, and select SMS.
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How do I…?

…add a new modem?
You can add a new modem if your modem is not on the list of pre-defined modems.
To do this:
1. Open the Modems section of the Control panel in the System screen.
2. Tap the New button.
3. Give the new modem a name and enter the appropriate details for your type of modem. Tap OK.

Check your modem’s documentation for the correct settings.

For more information on the details you need to enter for your modem, tap the Help button on each page of the
dialog.

…add a new mobile phone modem?
If the modem or phone you want to add is a mobile device, follow the steps below to ensure you can use your modem for
sending SMS messages.
To add a mobile modem:
1. Open the Modems section of the Control panel in the System screen.
2. Tap the New button.
3. Give the new modem a name and enter the appropriate details for your type of modem.
4. On the Advanced page, select Mobile in the Modem type line. Tap OK.

…remove a modem from the list?
To remove any of the modems from the list of pre-defined modems:
1. Open the Modems section of the Control panel in the System screen.
2. Select the modem you want to remove and tap Delete.

…control the modem loudspeaker?
To change the volume of the modem loudspeaker:
1. Open the Modems section of the Control panel in the System screen.
2. Select your Current modem and tap Edit.
3. On the Options page:
• Use the Loudspeaker in use line to control when the loudspeaker is on.
• Use the Volume line to control the loudspeaker volume.

…change the modem speed?
You can change the speed at which your Series 5 communicates with your modem. You may want to lower the speed if
you are having difficulty connecting.
To do this:
1. Open the Modems section of the Control panel in the System screen.
2. Select your Current modem and tap Edit.
3. Use the Speed line to select the appropriate speed for your modem.



Setting up for the Internet 15

…use an infrared modem?
If you have a suitable infrared-enabled modem, it can communicate with your Series 5 via the infrared port instead of the
serial port.
To set up your Series 5 to use an infrared modem:
1. Set up the modem and Series 5 so that their infrared ports are facing each other.
2. Connect the modem to a phone line.
3. Open the Modems section of the Control panel in the System screen on your Series 5.
4. Select your Current modem and tap Edit.
5. On the Modem page, set the Connect via line to Infrared.

If your infrared modem is a mobile phone, tap on the Advanced  page and make sure the Modem type line is set to
‘Mobile’.

…just dial the number I type?
You can set your Series 5 to dial the number you type without adding any dial out codes or chargecard information you
might have set up.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap the Edit button.
3. Remove the tick from the Use “smart” dialling box on the Service page.
4. Enter the phone number exactly as you want it to be dialled in the Standard dial-up number line.

Turning smart dialling off means that your Series 5 will only dial phone numbers exactly as you enter them: it will
not add dial out codes or chargecard information, and will not remove area and country codes even if the number is
in your local area.
However, turning smart dialling off does not make the Series 5 ignore all location settings. If you have set up
alternative access numbers for the different locations you dial from (using the Other dial-up numbers line in this
dialog), your Series 5 will still dial the access number corresponding to your current location, but will not add or
remove any information to or from the numbers you type in.

…use a call back service?
You can set up a call back service, where the server you log into calls you back on a specified number. You may need to
use this for dialling into a work network, e.g. for security reasons.
To set your Series 5 to use call back:
1. Open the Internet section of the Control panel in the System screen.
2. Select the Internet service you want to set up the call back details for. Tap Edit.
3. On the Advanced page, tick the Use call back box, then either:
• Leave the Call back behaviour line as ‘Use server number’. Do this if the server you are dialling to knows the

number to call you back on.
• Change the Call back behaviour line to ‘Use number below’. Then, enter the number you want the server to call

back on in the Call back number line.

If you are using a mobile phone, make sure the call back number the server uses is your “data” number, and not your
“voice” number. Contact your phone network operator if you are unsure about this.

…add a new location?
You can add a new location to the list of locations already set up.
To do this:
1. Open the Dialling section of the Control panel in the System screen.
2. On the Location page, tap New.
3. Enter the settings for the new location. In particular, make sure you select the country and enter the area code of the

new location on the Location page. Enter any dial out codes you need to add on the Dial out page.

…tell my Series 5 to disable Call Waiting?
If you are dialling from a phone with a Call Waiting facility, you need to disable this before connecting to the Internet.
To set your Series 5 to automatically disable Call Waiting when it dials:
1. Open the Dialling section of the Control panel in the System screen.
2. On the Location page, select the location you dial from that has Call Waiting and tap Edit.
3. Tap on the Dial out page, and enter the code you need to disable Call Waiting in the bottom line.
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…change the dial out code?
To change the dial out code set for the current location:
1. Open the Dialling section of the Control panel in the System screen.
2. On the Location page, select your Current location and tap Edit.
3. On the Dial out page, enter:
• The number you need to dial before making a local call.
• The number you need before making a long distance call.

If you would normally pause after dialling the dial out code, put a comma after the number. If you would normally
wait for a proceed tone after the dial out code, tick the Wait for proceed tone box on the Dial settings page.

…use pulse dialling?
If you are on a telephone exchange where you can’t use tone dialling (the standard setting used by your Series 5), you can
set your modem to use pulse dialling.
To do this:
1. Open the Dialling section of the Control panel in the System screen.
2. On the Location page, select your Current location and tap Edit.
3. On the Dial settings page remove the tick from the:
• Tone dial inside box if the internal exchange you use does not support tone dialling.
• Tone dial outside box if the external telephone exchange you use does not support tone dialling.

…use a chargecard?
You can set up your Series 5 so that it automatically enters chargecard details as it dials a number.
To do this:
1. Open the Dialling section of the Control panel in the System screen.
2. Select the location where you want to use the chargecard on the Location page and tap Edit.
3. On the Chargecard page, tick the Use a chargecard box.
4. Either select your chargecard and tap Options then Edit, or tap Options and select New if your card isn’t displayed

in the list.
5. On the Details page:
• Enter your account number.
• Enter and confirm your PIN.
6. On the Rules page:
• Use the letters (representing your chargecard details such as account number and PIN) to specify the order

information should be sent in when dialling local, national and international phone numbers.

For more details on rules for chargecards, tap the Help button on the appropriate dialog.

…disable a chargecard?
If your current location is set up to use a chargecard but you don’t want to use one the next time you connect, you can tell
the Series 5 not to use it without removing any of the chargecard settings.
To do this:
1. Open the Dialling section of the Control panel in the System screen.
2. Select your Current location on the Location page and tap Edit.
3. Tap on the Chargecards page and remove the tick from the Use a chargecard box.

…tell the modem not to wait for a dial tone?
You may experience problems dialling out if the dial tone on your phone line is non-standard, or if you are in a country
where the dial tone is different from the country where the modem was bought.. You may be able to avoid these by
instructing the modem not to wait for a dial tone before trying to connect.
To do this:
1. Open the Dialling section of the Control panel in the System screen.
2. Select your Current location and tap Edit.
3. Tap on the Dial settings page and remove the tick from the Wait for dial tone box. Tap OK and close the Dialling

section.
4. Open the Modems section of the Control panel.
5. Select your Current modem and tap the Edit button.
6. On the Initialisation page, append “X0” to the characters in the Data init. string line. Tap OK.
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…change the length of time I stay connected for?
You can change:
• The length of time that your Series 5 stays connected to the Internet when no data has been transferred to or from

your Series 5.
• The length of time your Series 5 stays connected after you go to close the last mode of connection.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service. In the If idle, stay online for line, set the length of time you want the

connection to stay open when no data has been transferred. The minimum setting for this is 1 minute.
3. In the On exit, stay online for line, set the length of time you want the connection to stay open after you have gone

to close the last mode of connection.

You can connect to the Internet through more than one mode (e.g. a remote mailbox, Internet program or while
sending an email). The On exit, stay online for option only comes into effect when you go to close the last mode of
connection. If you select Disconnect from Internet from the File menu in Web or Email, the above option is ignored
and the connection closes immediately.

…set alternative access numbers?
You can set alternative access numbers so that your Series 5 will dial the appropriate number according to your location.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap Edit.
3. Tap the Edit button in the Other dial-up numbers line.
4. Select whether you want to set one or two alternative numbers, then for each number set:
• The location you want it to be used for.
• The number itself, including the country and area code.

…disable my alternative access numbers?
If you’ve set up alternative access numbers for each location you dial from, but don’t want to use them at present, you can
turn them off without losing the setup details.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap the Edit button.
3. In the Other dial-up numbers line on the Service page, tap the Edit button.
4. In the Use other numbers line, select ‘None’.

…add a new Internet service?
You can add a new Internet service if you don’t want to use or edit any of the pre-defined services.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Tap the New button.
3. In the Based upon line, select ‘Internet service’ if you want the new service to start off with the same settings as one

you currently use. Select ‘Standard settings’ if you want the new Internet service to start off with a set of standard
details. Tap OK.

4. Give the new Internet service a name and change or add any details as necessary. Make sure that at the least you
include the phone number (including the country and area code) that you dial to connect to your service provider.
Tap Done.

…add a new Internet service based on a template?
You can create a new Internet service based upon a file (called a template) which contains settings for your Internet
Service Provider. You may be able to get a suitable template from your service provider, from the PsiWin CD ROM or
from our Web site at ‘www.mobile.psion.com’.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Tap the New button.
3. In the Based upon line, select Settings from file, then use the other dialog lines to locate the template file. Tap OK.
4. Change any of the details of the Internet service as appropriate, then tap Done.
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…remove a Internet service from the list?
To remove any items from the list of Internet services:
1. Open the Internet section of the Control panel in the System screen.
2. Select the Internet service you want to remove in the Current Internet service line and tap Delete.

…set up a direct-line connection?
If you have a direct connection to the Internet (as opposed to a dial-up connection), you can set up the Series 5 so that it
doesn’t dial out.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap the Edit button.
3. On the Service page, tap the Direct radio button in the Connection type line.

…specify my IP address?
Some Internet Service Providers require you to specify your IP address when you log on. You can set up your Series 5 to
do this for you automatically or you can manually enter your IP address.
To specify your IP address manually:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap the Edit button.
3. Tap on the Addresses page and remove the tick from the Get IP address from server box.
4. Enter your IP address in the line below.

…specify the DNS addresses?
Some Internet Service Providers require you to specify the addresses of the DNS machines (these are often known as
name servers). You can set up your Series 5 to do this for you automatically or you can manually enter your DNS address.
To specify your DNS address manually:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap the Edit button.
3. Tap on the Addresses page and remove the tick from the Get DNS addresses from server box.
4. Enter the Primary and Secondary DNS addresses in the lines below.

…enable PPP extensions?
If you know that your Internet Service Provider requires you to use PPP extensions, follow the steps below. If you’re
unsure, you should not enable them.
To enable PPP extensions:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap the Edit button.
3. Tap on the Advanced page and tick the Enable PPP extensions box.

…disable plain text authentication?
If your Series 5 cannot login using any kind of password encryption security, it will send your login details as plain text. If
you consider this to be a security risk, you can prevent your Series 5 from doing it by not allowing plain text
authentication.
To do this:
1. Open the Internet section of the Control panel in the System screen.
2. Select your Current Internet service and tap the Edit button.
3. Tap on the Advanced page and remove the tick from the Allow plain text authentication box.

...change where messages are stored
Normally messages are stored on the Series 5’s internal disk (C). You may prefer to store them on another disk, e.g. a
Memory disk (D), in order to save memory.
To change the location for storing your messages:
1. Open Email.
2. Select Move message store from the Tools menu.
3. Select the disk on which you want to keep your messages and tap OK.



Setting up for the Internet 19

Appendix:
The scripting language

Overview of creating connection scripts
The Internet section of the Control panel in your machine’s System screen provides a simple and easy-to-use scripting
language. This enables you to automate your connection if your Internet Service Provider requires a text-based login. You
can use this scripting language to create a script that sends details such as your username and password to the service
provider’s machine automatically when you connect.

When to use scripts
Some Internet Service Providers require you to log in at a terminal prompt. This text-based login will usually involve the
service provider’s machine prompting you for details such as your username and password, and you typing them in. If
your service provider requires you to log in like this, you will need to use a script.

How to use scripts
To use a script for logging in:
1. Open the Internet section of the Control panel in the System screen.
2. With the Internet service you use selected, tap the Edit button.

Read the earlier sections of this guide for information on selecting the appropriate Internet service and setting up the
Internet section of the Control panel.

3. Tap on the Login page and put a tick in the Use login script box.
4. You should enter the appropriate script in the script editor below.
5. Once you’ve entered your script, tap Done. Web and Email will now use your script when connecting to the Internet.

When you create a new Internet Service Provider in the Internet section of the Control panel, and tick the Use login
script box on the Login page, you will find a “generic” script provided in the script editor. You should be able to
tailor this to your own service provider’s needs rather than have to create a new script from scratch. To learn more
about creating and editing scripts, read the following sections.
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Creating a script for your Internet Service Provider
Creating a script for connecting to your Internet Service Provider consists of two stages:
1. Recording the process of logging in, so that you have something to base your script on.
2. Writing the script based on the record of your logging in.

Recording the logging in process
Recording the process of logging in to your Internet Service Provider is best done using the Comms program, rather than
Email. This has a “capture” facility, which stores the whole logging in process as a text file, which you can then use as a
guide when writing your script.
To set up your machine to capture the logging in process using Comms:
1. Connect your Series 5 to a modem and the modem to a telephone line.
2. Close all Internet programs such as Email and Web, select Remote link on the Tools menu in the System screen and

set the Link line to ‘Off’.
3. Tap on the Extras icon, then tap on the Comms icon.
4. Use Communication settings on the Tools menu in Comms to set the same options for speed, handshaking, etc. as

you normally use for your modem. Tap OK.

If you aren’t sure which settings you normally use, open the Modems section of the Control panel in the system
screen, and tap Edit with your modem selected. You should replicate the settings on all the pages of this dialog in the
Communication settings section of Comms.

5. Select Translate codes on the Tools menu and remove the tick from the Local echo box.
6. Make sure the Port active line on the Transfer menu is ticked, then select Capture to file on the same menu.
7. Give the “capture file” a name and location and tap OK.
You are now ready to dial your Internet Service Provider and log in.
To do this:
1. Type ‘AT’ and press Enter. You should see ‘OK’ appear below the ‘AT’ in the Comms screen.
2. Enter your modem initialisation string and press Enter. This will often be ‘ATZ’ or ‘AT&F’.

If you do not know the initialisation string for your modem, open the Modems section of the Control panel, select
your modem and tap Edit. Move to the Initialisation page and make a note of the information in the Data Init. string
line.

3. Type ‘ATDT’ followed by the telephone number you need to dial to connect to your Internet Service Provider,
including any codes you have to add to get an outside line. Press Enter.

Your modem will dial the access number you entered and “handshake” with the modem at the other end of the line for a
while once the call has been answered. If you have the modem loudspeaker on, you will hear high-pitched sounds at this
stage. When this has stopped, you can log in.
To log in:
1. A short while after the modem noise has finished, you should be presented with a prompt. This will normally be

‘Username:’, ‘login:’ or something similar.
2. Enter the information required by the prompt and press Enter. Repeat this process for any other prompts your Internet

Service Provider sends you.
3. When you have finished logging on, the server will normally send a welcome message, e.g. ‘HELLO’ or

‘CONNECTED’.
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You can now stop the capturing.
To do this:
• Remove the tick from the Capture to file command on the Transfer menu.
You should now also disconnect from your Internet Service Provider.
To do this:
• Select Hangup on the Transfer menu.

Viewing your capture file
Once you’ve captured the logging in process, you may want to view and print out a copy of the information you’ve
captured, to help you create your script.
To view the capture file:
1. Open Word.
2. Select More|Import text file on the File menu.
3. Locate the file you created when starting the capture. Tap OK.

Creating a script from your record of logging in
Once you’ve made a record of the logging in process, you are ready to start writing your script in the script editor.
To open the script editor:
1. Open the Internet section of the Control panel in the System screen.
2. With the Internet service you use selected, tap the Edit button.
3. Tap on the Login page and put a tick in the Use login script box.

Script writing
The capture file you created while logging in will normally look something like this:

The guiding  principles for writing your script are that it should:
• Wait for specific prompts, e.g. ‘login:’ from the Internet Service Provider’s machine. This is done using the WAIT

command.
• Send the appropriate responses, e.g. your username followed by Enter. This is done using the SEND and READ

commands.
• Exit after completing the login process, or exit reporting an appropriate error if something went wrong.

The items you had to
respond to during
the logging in
process are the
prompts you instruct
the script to wait for.

The responses you gave
to each prompt are the
items you tell the script
to send in reply.

Your capture file will
also include other
information sent to you
by the server, as well as
the information you
typed during the dialling
process.
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In addition, you should split the different parts of your script into procedures (a procedure is a section of script that
begins with a name that you can then use to jump to the commands it contains from anywhere else in the script).
• Each procedure should begin with a name followed by a colon, then be followed by instructions on the next line. E.g.

in

start:
WAIT 15

“start” is the name of the procedure. You can make the script jump to the start procedure from anywhere else in the
script by using the command:

GOTO start

The maximum length of a procedure name (or “label”) is 20 characters.

Waiting for prompts
To use a script to tell the machine to wait for a prompt:

You should use a WAIT command for each of the prompts your Internet Service Provider sends you during the
logging in process.

1. Open the script editor.
2. Create a new procedure for the prompt you want the script to wait for by typing the procedure name followed by a

colon. E.g.

waitforlogin:
3. On a new line, type WAIT followed by the number of seconds you want the machine to wait for the prompt. Then

start another new line and type a ‘{‘ character. You will now have something like:

waitforlogin:
WAIT 15
{

When writing scripts, it is often useful to indent each new line using the Tab key. This helps you to identify
procedure names when looking over your script.

4. On another new line enter the prompt the machine should wait for in “” marks, then type the name of the procedure
the script should jump to when it receives the prompt. (This will be the procedure which contains the command for
sending the appropriate response.) Start a new line then add a ‘}’ character. You should now have something like:

waitforlogin:
WAIT 15
{
“ogin:” sendlogin
}

Because the scripting tool is case-sensitive, and your Internet Service Provider may send the prompt ‘login:’ or
‘Login:’, it is often better to miss out the first letter or two when entering the prompt in the WAIT command.

If you are typing the procedure name (sendlogin in the above example) somewhere other than at the beginning of a
procedure, you should not put a colon at the end.
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5. On a new line, type the command that you want to be carried out if your machine does not receive the prompt you
have specified. E.g.

waitforlogin:
WAIT 15
{
“ogin:” sendlogin
}
GOTO failure

will make the script jump to the procedure named failure if the characters ogin: are not received within 15 seconds.
Your script should include a WAIT command for each of the prompts your Internet Service Provider sends you during the
logging in process. Each of these should be matched by a SEND command returning the appropriate response.

Sending responses
You can use the SEND and READ commands to send a response to your service provider, for example when the login
process requires a password or user name. Use the SEND command when you wish to send text or a variable, or use the
READ command when you need to prompt the user to type in a response.

Using the SEND command to sent text:
1. On a new line, type the procedure name followed by a colon.
2. On the line below, type SEND followed by:
• The text you want to send, within “” marks, or
• The characters login_name$ if you want your Series 5 to send whatever you have entered in the Username line on

the Account page for your Internet service.
• The characters <0x0d> wherever you would normally press Enter if you were logging in manually.
• Any combination of the above, joined together using the + character. E.g.

SEND login_name$+<0x0d>
3. You might want to follow your SEND command with the next appropriate WAIT command. E.g., after sending your

username, you may want to instruct the machine to wait for the ‘password:’ prompt:

sendlogin:
SEND login_name$+<0x0d>
WAIT 15
{
“word:” sendpass
}
GOTO failure

You should repeat the above steps of creating WAIT and SEND instructions for each prompt which the server sends that
requires you to respond.
To send the information entered in the Password line on the Account page for your Internet service:
• Use SEND login_pass$ and add +<0x0d> if you would normally press Enter after typing the password.
To send the information entered in the IP address line on the Addresses page for your Internet service:
• Use SEND login_ipaddr$ and add +<0x0d> if you would normally press Enter after typing the IP address.
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Using the READ command to send text:
Use the READ command in place of the SEND command when the user is required to enter details every time they login.
For example, you may wish to use the READ command when the user connects to a ‘challenge response’ system which
displays a code, and then expects to receive a corresponding password to match that code. When the READ command is
used in a script, the Post-Connection Terminal (PCT) dialog will be displayed. If the user types text into the PCT dialog
and presses Enter, the text (including the carriage return character) are sent to the server. The following section of script
uses the SEND command to send the login name, followed by the READ command to let the user enter their password:

sendlogin:
SEND login_name$+<0x0d>
WAIT 15
{
"word:" sendpass
}

sendpass:
READ

After sending the login name, the script jumps to the  sendpass procedure. In the sendpass procedure, the READ
command lets the user type their password in the PCT dialog. After the user types in their password and presses  Enter,
the text is sent to the server and the script continues at the point after the  READ command.

Exiting the script
Once your script has instructed the machine to wait for all the appropriate prompts and to send all the appropriate
responses, it should stop running. You can instruct it to do this by using the EXIT command, as in the following example:

sendpass:
SEND login_pass$+<0x0d>
WAIT 15
{
“ello” success
}

success:
EXIT

Here the machine sends your password, then waits to receive ello (your service provider’s server will normally respond
with a message such as “hello” or “OK” when you have logged in successfully). If this is received, the machine jumps to
the success procedure, which stops running the script.
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Making the script report errors
You can instruct the script to report any problems experienced during logging in.
There are two useful ways of doing this:
1. At the point in the script where you think there could be a problem, use the EXIT command, together with one of the

pre-defined error strings, e.g.:

sendlogin:
SEND “fred15”
WAIT 15
{
“word:” sendpass
}
GOTO loginfail

loginfail:
EXIT KErrLoginFail$

This section of script sends the username fred15, then waits to receive word:. If this is not received within 15
seconds, the script jumps to the loginfail procedure, which closes the script at the same time as reporting a login
failure.

There is a full list of the different errors that you can use with the EXIT command in the EXIT section of the script
glossary below.

2. Use the WAIT command to wait for more than one response, including alternative responses which may indicate that
the server is reporting an error. E.g.

sendlogin:
SEND “fred15”
WAIT 15
{
“word:” sendpass
“nvalid” badlogin
“ncorrect” badlogin
“rror” failure
}
EXIT KerrTimeOut$

badlogin:
EXIT KErrLoginFail$

failure:
EXIT KErrGeneral$

In the above section of script, the machine sends the username fred15, then waits to receive word:. If this is received
within 15 seconds, the script jumps to the sendpass procedure (not detailed in the above extract). If, instead, your
machine receives the nvalid, ncorrect or rror prompts, the script will jump to either the badlogin or failure
procedures, depending on the kind of error being reported. If none of the above messages are received within the
allowed time, the script will exit with a “timed out” message.
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Scripting language commands
This section contains a list of all the commands in the scripting language. Each entry in the list is laid out as follows:

Any items contained within [ ] marks are optional.

! ! [comment]
“Comments out” text: the software will ignore all text from the exclamation mark to the end of the line. E.g.

! send my username now

SEND “fred15”

EXIT EXIT [expression$]
Exits the script. If a string is provided (represented by expression$), e.g. “No carrier” or “Logging in complete”, that string
is displayed as an information message when the script finishes.
You can display a pre-defined error while exiting if you replace expression$ with one of the following items:

KErrNoModem$ Reports that no modem was detected.
KErrNoCarrier$ Reports that there was no phone line detected.
KErrNoDialTone$ Reports that no dial tone was detected on the phone line.
KErrBusy$ Reports that there was an engaged tone after dialling.
KErrNoAnswer$ Reports that the phone at the other end was not answered.
KErrLoginFail$ Reports that there was a problem during login.
KErrGeneral$ Reports a general error.
KErrModemError$ Reports that there was an error with the modem.
KErrModemInitError$ Reports that there was an error initialising the modem.
KErrModemResetError$ Reports that there was a problem resetting the modem.
KErrTimeOut$ Reports that the machine timed out waiting for a response.

GOTO GOTO label
Makes the script jump to the label you specify. When using a label in a GOTO command, you do not need to add a colon
onto it.

LOOP LOOP m
{
…
}
Repeats the commands contained within the brackets m number of times. When the commands have been repeated the
specified number of times, the script moves on to the next command.

READ READ
Instructs the software to display a Post-Connection Terminal (PCT) dialog, allowing the user to enter text such as a
password. If the user types text in the PCT dialog and presses Enter, the text (including the carriage return) is sent to the
server.

SEND SEND expression$
Sends the text represented by expression$ to the remote server. The text used as expression$ should be within “” marks.
Alternatively, you can send a variable you have defined using the SET command. See the entry below on the SET command
for more details.

The syntax for the
command, showing how
it should be used.

An explanation of what
the command does.

The script
command itself.
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SET SET VariableName$=expression$
Defines the variable VarName$ as the expression expr$. You can use variables to represent text. E.g., if at the start of your
script you had the line:

set login$=“fred15”
then at any point later in your script you could use:

SEND login$
which would send the characters ‘fred15’.

Variables must be text strings, and cannot be numeric. All variable names, therefore, must end with a ‘$’ sign.

The maximum length of a variable name is 20 characters, including the ‘$’ sign. Using a variable name longer than
this will result in an error occurring during the login process.

WAIT WAIT n {
expr1$ label1
expr2$ label2
expr3$ label3
…
}
The WAIT command pauses the script for n seconds, or until any of the specified strings is received. If none of the
expressions between the brackets are received by the time n seconds have passed, the script moves on to the next command.
If, during the n seconds, one of the strings is received, the script jumps to the label specified alongside that string.
E.g.

WAIT 15
{
“Protocol:” sendprot
“elcome” stopscript
}
EXIT

If you use the line:
WAIT n {}
in a script, the machine will pause for n seconds, then continue with the next command in the script, regardless of any
text received during that period.
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